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***************************************
A Day in the Life . . . The Best of Times
by Curt B. Witcher
***************************************
I had a truly fantastic day on Tuesday, August 2nd, and it reminded me all over again that these are
truly the best of times for genealogists. I thought I would share some of that day with you.
The day started very early in the morning with an email that contained an Excel file of transcribed
tombstone inscriptions. A number of individuals are updating cemetery readings that were done in
northeast Indiana cemeteries decades ago. They read the tombstones, key the data, email it to me,
and it‛s queued-up for website presentation at GenealogyCenter.org. I couldn‛t help but muse about
the stark difference between the process used thirty years ago and the process used today. From
the old process of gathering the data, writing the information on index cards, alphabetizing the
index cards, typing the information from the cards, and binding the finished work for access on our
Center‛s shelves to the new process of keying, emailing and posting the data online for access by
anyone, anywhere with an Internet connection. WOW--the best of times! (We have wonderful
volunteers working with us, on everything from cemetery transcriptions to obituary abstracts, and
more! We are truly blessed.)
Mid-morning, I had an engaging meeting with our library‛s Young Adult Services manager about a
program she is putting together to involve youth in deploying technology in ways that stimulate
critical thinking, engage their surroundings, and enable them to be responsible users of 21st
century technology. The program, which she is calling “Studio D” (D for digital), may be eligible for
grant funding. Our conversation focused on how engaging young people in discovering their stories-the stories of their families, their neighborhoods, their ethnicity--might be a meaningful, and
perhaps even life-changing, way for them to learn and utilize contemporary technologies. My mind
quickly raced to the possibilities of using the rap music genre to tell a family or community story.

Young people are drawn to that genre of music--how cool would it be to have some positive rap.
What about a family or local history mash-up (for those not familiar with the term:
<http://en.wikipedia.org/wiki/Mashup_(web_application_hybrid)>) using visuals of documents,
artifacts and locations along with digital interviews and electronic diaries? This could be an exciting
and engaging way to foster the next generation of genealogists. The future of genealogy and family
history will definitely look more like this than a paper family album or published family history.
Late afternoon that same Tuesday, I joined a former colleague and the director of the Macedonian
Patriotic Organization at the historic Fort Wayne Lindenwood Cemetery. The three of us were on a
mission prompted by a curiosity. A photograph taken at the time of a burial in the early part of the
last century prompted that curiosity. Could we confirm that the picture was taken in Lindenwood
and further, could we stand on the exact location of those mourners nearly a century ago? We did
determine before arriving at the cemetery that there was a burial of the same name in the
Lindenwood records. A quick stop at the cemetery office provided the section and row number for
the grave. The cemetery‛s executive joined us at the section, and after a brief period of looking, we
found the grave. Something didn‛t look quite right, though, standing in front of the grave and
looking at the very old trees and the shape of the ground behind the grave. Could this possibly not
be the grave in the picture? Musing, and walking around behind the tombstone, we suddenly stopped
and surveyed the ground from behind the marker--the stretch of ground in front of the marker
that now included a road. And there was a match! The slope of the land, a number of the same
trees, now much older and taller--they all fit into the photograph. There was something awesome,
something touching, something nearly sacred about sharing that same ground with those mourners
from generations ago and honoring again the ancestor buried there. Next year, when those with
Macedonian meet in Fort Wayne, we will be honored to share that place with those gathered.
Touching the present, the past, and the future all in the same day--fantastically wonderful!
***************************************
The “Swem Index”
by John D. Beatty
***************************************
Virginia is a challenging state in which to research. While genealogists will find extensive published
sources for many counties, including histories and record extracts, they also have to deal with the
significant loss of original records through courthouse fires. However, many useful sources from
the seventeenth, eighteenth and early nineteenth centuries, even for so-called “burned counties,”
have been published in various periodicals and statewide sources.
The essential tool for accessing names in these sources is E. G. Swem‛s “Virginia Historical Index”
(Gloucester, MA: Peter Smith, 1965) (Gc 975.5 Sw41vi). Often referred to simply as the “Swem
Index,” it provides access to tens of thousands of names, mostly for the colonial period, from
several major Virginia periodical series: “Lower Norfolk County Antiquary,” the “Virginia Historical
Register,” the “Virginia Magazine of History,” “Tyler‛s Quarterly,” and the first and second series
of the “William and Mary Quarterly.” These journals, in their early years, published a great variety
of historical and genealogical information, including family histories and abstracts of numerous
original records, manuscript letters, and articles of local interest on historical subjects. Swem also
covered two major secondary sources for the seventeenth and eighteenth centuries: the “Calendar

of Virginia State Papers” and “Henning‛s Statutes at Large,” both of which contain legislative
records from the House of Burgesses, including many names of petitioners and correspondents to
that body.
Arrangement in the Swem Index is alphabetical. After each name, users will see a volume number of
the source followed by a letter code for that source, then the page number where the name can be
found. For example, among several references for Hutchins Burton, one will find “8C120” and
“17W(1)228.” The first indicates volume 8 of the “Calendar of Virginia State Papers,” page 120; the
second refers to volume 17 of the “William and Mary Quarterly,” first series, page 228. Swem went
beyond the simple listing of names to include a variety of subject references to places and specific
types of documents, such as family Bibles, slave records, and petitions. Again using the Hutchins
Burton example, we find a reference specifically to his slaves in one entry.
The Swem Index is a useful tool for anyone doing research in colonial Virginia and should be one of
the first sources consulted.
***************************************
The Reverend Joseph Brown Turner Collection
by Steven W. Myers
***************************************
Today‛s genealogists are quick to consult the internet for family trees, already posted by others,
that may serve as an ancestry shortcut. While the cautious genealogist will favor documented work
as a guide for their own additional searches, others sometimes just copy the undocumented
lineages. Consulting the previous work of other genealogists is a good idea that can save time and
money on your own project, but why not utilize the results of efforts by accomplished and
experienced investigators? Many genealogists are simply unaware of the potential sources.
For those with ancestors resident in the Delmarva Peninsula, the Reverend Joseph Brown Turner
Collection is one such valuable source. The collection consists of the Reverend Turner‛s genealogical
notes on some three thousand families who lived in Delaware and on the eastern shores of Maryland
and Virginia. He was particularly interested in Presbyterian families and compiled extensive files
containing notes of family interviews, and extracts from a variety of records including probate
files, deeds, and church registers, as well as copies of some published material. The records range
in content from the medieval period to 1935, but principally concern the 17th through 19th
centuries.
A copy of the original Turner Collection, now housed at the Delaware Public Archives, is available on
647 microfiche in The Genealogy Center (cabinet F-5). A card file index is reproduced on the first
40 microfiche and provides references to families from Abbe to Zug, followed by references to
places from Alabama through Wisconsin, and then to those for foreign localities. Each entry
includes a location and a source reference. Some index citations refer to published books and
articles which are not part of Turner‛s manuscripts, but can be found elsewhere in The Genealogy
Center‛s collections. Each fiche represents a folder of the manuscript notes, which are reproduced
alphabetically by family from Abbott through Zimmerman on microfiche 41-647.
The range of the Reverend Turner‛s investigations into the roots of Delmarva families is

demonstrated by the inclusion in his notes of extracts from early Irish parish registers in counties
Antrim and Down. Those transcripts, concerning 23 surnames, have been rendered especially
valuable because of the loss of the original records. As with any genealogist‛s work, these notes do
contain mistakes, but researchers will find a rich vein of material that can be profitably mined and
then verified in original sources.
***************************************
Exploring the Ribbon: Home Tab
by Kay Spears
***************************************
Before we look at the Home tab on the “ribbon” in Microsoft Word, please note the handy zoom tool
in the lower right-hand corner of your screen. Use this easy slide tool to zoom in and out on your
document.
The Home tab contains five default command groups: Clipboard, Font, Paragraph, Styles, and
Editing. For the first four, additional options are available by clicking on the little arrow in the
lower right-hand corner of each group.
Clipboard Group: This is the copy and paste group. I usually use keyboard shortcuts for copying
(Ctrl+c) and pasting (Ctrl+v), but the tools in this grouping can also be used. Clicking on the little
arrow in the bottom right corner of the group opens the Clipboard Task Pane, which shows the
copy/paste items being stored. You can store up to 24 items on the Clipboard. Also available in the
group is an object called a Format Painter, which looks like a yellow paint brush. This copies
formatting. Select some formatted text. Then, choose the Format Painter, go to the new text you
want formatted and select. The new text will be formatted to match. This tool is handy if you are
trying to duplicate a “look.”
Font Group: This is the location of all your font tools. Please take time to experiment with the Text
Effects tool, which can help turn boring text into something quite interesting. Clicking on the little
arrow in the lower right hand corner opens the Font Dialog box. This is one of the places where you
can change default font settings.
Paragraph Group: Bullets, Numbering and Sort are located in the Paragraph group, along with
options for text alignment and spacing. The Paragraph dialog box (again, lower right hand corner) is
the same as the one in the older version of Word and is also another place where you can change
your default settings. The object that looks like a paint bucket is the Shading Tool. This adds
background highlighting to text.
Styles Group: Styles for headings are located here. This is also where you can change the line
spacing from 1.15 to 1. Change Styles>Style Set>Word 2003.
Editing Group: Find, Replace and Select are located here. You can also use your keyboard for
selecting. Hold your Shift key down, then using the arrow keys, move across or down the text you
want to select. Shift+arrow moves across one character or down one line at a time. Shift
+Ctrl+arrow moves across a whole word or down one paragraph with each arrow keystroke.

I highly recommend using the default tools for a while before you start customizing.
Next: the Insert Tab.
***************************************
Quick-Tip of the Month for Preservation--“Final” Resting Place for Your Documents & Heirlooms
by John D. Beatty
***************************************
We all know the importance of keeping our family documents in acid-free file folders and boxes and
our photographs in archival-quality plastic or mylar sleeves. We have also discussed in this column
the importance of labeling our photographs and cataloging and identifying our family heirlooms, such
as that vase you inherited from your great-grandmother, and then maintaining an inventory of those
items. We have also talked about keeping our genealogical records in good order and even publishing
our family history in some form and leaving it in a genealogical library.
But what happens to all of these precious items when you die? Have you made provision for your
heirlooms in your will? Some people will have younger generations interested in genealogy who they
know will gladly accept heirlooms and photo albums and agree to preserve them. If so, you should
first be thankful, and then formalize in writing a bequest of these items to that heir in your will.
Sadly, many have no such heirs and face the prospect of having their treasured heirlooms sold at an
estate sale or even thrown into a dumpster. Don't let that happen to you. Consider the alternatives
while you still can. If you have no interested heirs, see if there is a library or historical society in
the area where your family lived - or even a state library or historical society - that would accept
your family photos, Bibles, and letters. Make arrangements to donate them while you can, or make
an appropriate provision in your will for your heirlooms to go there. Digitize your family photos and
family Bible pages and create a family memory book - even if it is not a full-scale genealogy - and
consider donating it to a library. The peace of mind is well worth it.
[Editor‛s note: If you want to share digitized data with others, including Bible records, diaries, and
personal papers, you can simply send a disk copy to The Genealogy Center stating we have your
permission to share the data online.]
***************************************
Family History: Beyond the Basics Mini-Course
***************************************
If you want to get in on this extremely popular course, you‛d better register soon. Seventy-five
percent of the space is already booked! This informative mini-course, "Family History: Beyond the
Basics," is being offered September 30 & October 1, 2011. Instructors Margery Graham and Steve
Myers will share their knowledge, guide tours of The Genealogy Center, and provide assisted
research and personal consultations. "Family History: Beyond the Basics" will cover the following
topics.
Day One:
Session 1: Problem Solving: Breaking through Brick Walls in Your Research - Every family historian
eventually encounters obstacles in their research that seem insurmountable. Learn some basic
strategies for tackling these so-called "brick walls" that can lead you to genealogical

breakthroughs.
Session 2: Probate Records - Learn how to find and use wills, administrations and guardianships, as
well as the other "goodies" contained in probate records.
Session 3: Land Records and Tax Lists - Learn the basics of land descriptions and how deed and
land grant records, as well as associated tax lists, can all help advance your research.
Day Two:
Session 4: Military Records - Following an overview of military record sources, learn the basics of
researching ancestors who served in the American Civil War (1861-1865) and in the American
Revolutionary War (1775-1783).
Session 5: Church Records - Learn how to identify, locate and use these important sources of early
birth, marriage and death information for a time period that pre-dates government registration of
so-called "vital records."
Session 6: Tracing Your Ancestors Across the Atlantic - Learn how to find and use the many
sources that bear on this crucial research step. Naturalization records, passenger lists, European
emigration records and other sources will be discussed.
This course will be in Rooms A & B of the Main Library, 900 Library Plaza, Fort Wayne, Indiana. The
registration fee for the "Family History: Beyond the Basics" mini-course is $50. Checks should be
made payable to "ACPL Foundation" and mailed to: The Genealogy Center, Allen County Public
Library, P.O. Box 2270, Fort Wayne, IN 46801-2270. Mini-course attendance will be limited, so
register early to avoid disappointment. In the past this mini-course has filled very quickly so act
today! Additional information and a workshop schedule will be posted soon on our Web site at
http://www.genealogycenter.org/Events.aspx.
***************************************
National Black Genealogy Summit
***************************************
The National Black Genealogy Summit will take place in Fort Wayne, Indiana, October 20-22, 2011,
at the Allen County Public Library and the Grand Wayne Convention Center. It will be quite likely
the best event for those interested in exploring African American family history since a similar
summit took place in Fort Wayne in October of 2009. An information-rich website, continually being
updated with the very latest information about the event, can be found at the following address:
www.BlackGenealogyConference.Info
Hosted by the Allen County Public Library and its Foundation, as well as the African American
Genealogical Society of Fort Wayne, this event has so many outstanding features that it thoroughly
entices one to participate. Planning partners for this event include the African/African American
Historical Society & Museum here in Fort Wayne; the Delta Sigma Theta Sorority, Inc., Fort Wayne
Chapter; the It Is Well With My Soul program initiative; and The Links, Incorporated, Fort Wayne
Chapter.

Last month we highlighted three of the Summit‛s speakers: Tony Burroughs, Tim Pinnick, and Angela
Walton-Raji. We want to continue highlighting the great line-up of speakers. Damani Davis, an
extremely knowledgeable and skilled archivist at the National Archives, will be speaking on “The
Kansas 'Exodusters:' Using Federal Documents to Explore the First African-American Migration
from the South” and “Immigrants from the Caribbean: Using Federal Records to Locate Black
Ancestors from the British West Indies.” Roberta Estes, a scientist, genealogist, and expert in the
use of DNA for family history research will be presenting two programs: “DNA and Genealogy: An
Introduction” and “Finding Your Native American and African American Heritage Using DNA.”
Shamele Jordan will be presenting three informative sessions: “Maps and Genealogy,” “Records of
Resistance,” and “Records of the Rebellion: Documenting African Americans in the Civil War.”
Shamele is a perennial crowd favorite because of the rich amounts of information she packs into
her lectures and her engaging presentation style. Lisa Lee, a professional genealogist, is the owner
of GotGenealogy.com, where she publishes a monthly newsletter, the Got Genealogy Gazette, which
provides timely and useful information to help genealogists make the most of their online
genealogical searches. She will be presenting, “Finding Blacks in Canada,” “Finding Your
‘Unfindables‛,” and “Search & Reward Notices.” You can see all the speakers and all the sessions
right now at www.BlackGenealogyConference.Info.
In addition to the program presenters throughout the Summit, there are three special
presentations planned: the ProQuest Plenary Session on Friday morning, October 21st, the
Ancestry.com Banquet on Friday evening, and the Friends of the ACPL Plenary Session on Saturday
morning, October 22nd.
Award winning author and historian, Carla Peterson, will present the Friday, October 21, 2011
plenary session titled, "What's Under the Dust? Recovering Family History from the Archives." Her
most recent publication is an amazing work titled, "Black Gotham: A Family History of African
Americans in Nineteenth-Century New York City." She is a must hear!
Robin D. Stone will be the banquet speaker on Friday evening, October 21st. Robin is an independent
journalist whose work focuses primarily on health, children, families, and parenting. She is author of
"No Secrets, No Lies: How Black Families Can Heal from Sexual Abuse" (Broadway Books, 2004).
Most importantly and recently, Robin penned a feature article, "A Legacy of Love & Pride" for the
February 2011 edition of Essence magazine, which traces the descendants of a slave on the
infamous L'Hermitage Plantation in Frederick County, MD to a young Atlanta woman. Robin was
Founding Editor-in-Chief of Essence.com, and Executive and Deputy Editor of Essence. Under her
stewardship, the magazine earned awards from Folio, the National Association of Black Journalists,
the New York Association of Black Journalists and the Congressional Black Caucus, among other
organizations. A journalist for more than 20 years, Robin started her career in newspapers. She
was an editor at The New York Times and The Boston Globe. Her contributions to journalism
garnered an Outstanding Alumni Award from her alma mater, Michigan State University, in 2004.
Robin also edited and contributed the Afterword to "My Times in Black and White: Race and Power
at the New York Times" (Lawrence Hill, 2010), the memoir by her late husband, Gerald M. Boyd.
That Friday evening will certainly be an evening to remember.
Visual artist and illustrator, Michele Wood, will give the Saturday, October 22, 2011 plenary session
titled, “Not to Be Forgotten: One Artist‛s Journey of Going Back Home.” Her award-winning and

nationally acclaimed art is vibrant and engaging, as is the story of how her family's history has
guided her hand. A large number of her best pieces will be on display during the Summit in the
library's Jeffrey R. Krull gallery. Her presentation is a must-hear; her exhibit is a must-see.
Register today, and bring a friend with you. The registration form is linked directly at:
www.BlackGenealogyConference.info/sites/default/files/nbgs-registration-form.pdf
***************************************
Family History Month 2011
***************************************
The Genealogy Center's annual Family History Month celebration is just a month away. As usual, we
have 31 days packed with educational opportunities for the genealogist, starting with our Family
History: Beyond the Basics mini-course. Other sessions will cover Family Tree Maker, blogging,
Microsoft Word, and Adobe Elements. One-on-One Consultations will take place by appointment
every Tuesday, as well as on the fourth Wednesday. As just mentioned above, the month will also
feature the National Black Genealogy Summit, an outstanding three-day event for researchers of
African American family history and heritage. See the calendar
<www.genealogycenter.org/Libraries/Brochures/FHM_Calendar.sflb.ashx> for dates, times and
other information. For more information or to register for most events, call 260-421-1225, or send
us an email at Genealogy@ACPL.Info.
***************************************
Military Seminar: You Say You Want a Revolution
***************************************
Join us for a day of learning how to locate your Revolutionary War ancestor on Saturday, November
12, 2011. This seminar will be presented by the Mary Penrose Wayne Chapter of the Daughters of
the American Revolution, the Anthony Halberstadt Chapter National Society Sons of the American
Revolution, and The Genealogy Center staff. This all-day event features methodology lectures,
historical presentations, opportunities for advice on lineage applications, and a tour of The
Genealogy Center.
In the morning, you will learn about the genealogical resources of the National Society Daughters
of the American Revolution including how to use the DAR's genealogical records collection and the
DAR library catalog. Tutorials on the application process for the DAR and SAR will be provided as
well as an examination of Revolutionary War pensions. In the afternoon, one will be given the choice
of attending an SAR meeting, featuring a program by William Sharp on "The Siege at Bryan's
Station," or attending a DAR meeting, featuring a presentation by Bob Jones who is a Revolutionary
Soldier Re-Enactor. Tours of The Genealogy Center will also take place in the afternoon. You can
even schedule a 30 minute consultation with a DAR or SAR member to discuss your specific
application to the organization. (Note: You must bring your lineage paperwork to the appointment.
Due to limited availability, send an email to Genealogy@ACPL.Info to schedule your consultation
time.) For more information, see the flyer at <www.genealogycenter.org/Events.aspx> Registration is
required for this free seminar. Please call 260-421-1225 or email Genealogy@ACPL.Info to register.
***************************************
Out and About

***************************************
Curt Witcher
September 6-10, 2011, Federation of Genealogical Societies Annual Conference, Springfield, IL
“Digital Lincoln: The Lincoln Financial Foundation Collection at the Allen County (IN) Public Library,”
“The Dollars and Cents of Fundraising,” “Becoming the Outstanding Leader Your Society Needs,”
“Records and Repositories at the Crossroads of America--Indiana Research,” and “Finding the
World with WorldCat.”
***************************************
Area Calendar of Events
***************************************
Allen County Genealogical Society of Indiana (ACGSI)
There are no society meetings during the summer months. Meetings resume in September.
September 14, 2011--Allen County Public Library, 900 Library Plaza, Fort Wayne, Indiana. 6:30 p.m.
refreshments and social time, 7 p.m. program. Curt Witcher will present: “America‛s Second
Revolution: Records & Resources for War of 1812 Research.”
Allen County-Fort Wayne Historical Society, 302 East Berry, Ft. Wayne, IN
The George R. Mather Sunday Lecture Series will resume again in the fall.
***************************************
Driving Directions to the Library
***************************************
Wondering how to get to the library? Our location is 900 Library Plaza, Fort Wayne, Indiana, in the
block bordered on the south by Washington Boulevard, the west by Ewing Street, the north by
Wayne Street, and the east by the Library Plaza, formerly Webster Street. We would enjoy having
you visit the Genealogy Center.
To get directions from your exact location to 900 Library Plaza, Fort Wayne, Indiana, visit this link
at MapQuest:
http://www.mapquest.com/maps/map.adp?formtype=address&addtohistory=&address=900%20Web
ster%20St&city=Fort%20Wayne&state=IN&zipcode=46802%2d3602&country=US&geodiff=1
>From the South
Exit Interstate 69 at exit 102. Drive east on Jefferson Boulevard into downtown. Turn left on
Ewing Street. The Library is one block north, at Ewing Street and Washington Boulevard.
Using US 27:
US 27 turns into Lafayette Street. Drive north into downtown. Turn left at Washington Boulevard
and go five blocks. The Library will be on the right.
>From the North
Exit Interstate 69 at exit 112. Drive south on Coldwater Road, which merges into Clinton Street.
Continue south on Clinton to Washington Boulevard. Turn right on Washington and go three blocks.
The Library will be on the right.

>From the West
Using US 30:
Drive into town on US 30. US 30 turns into Goshen Ave. which dead-ends at West State Blvd.
Make an angled left turn onto West State Blvd. Turn right on Wells Street. Go south on Wells to
Wayne Street. Turn left on Wayne Street. The Library will be in the second block on the right.
Using US 24:
After crossing under Interstate 69, follow the same directions as from the South.
>From the East
Follow US 30/then 930 into and through New Haven, under an overpass into downtown Fort Wayne.
You will be on Washington Blvd. when you get into downtown. Library Plaza will be on the right.
***************************************
Parking at the Library
***************************************
At the Library, underground parking can be accessed from Wayne Street. Other library parking
lots are at Washington and Webster, and Wayne and Webster. Hourly parking is $1 per hour with a
$7 maximum. ACPL library card holders may use their cards to validate the parking ticket at the
west end of the Great Hall of the Library. Out of county residents may purchase a subscription
card with proof of identification and residence. The current fee for an Individual Subscription Card
is $70.
Public lots are located at the corner of Ewing and Wayne Streets ($1 each for the first two halfhours, $1 per hour after, with a $4 per day maximum) and the corner of Jefferson Boulevard and
Harrison Street ($3 per day).
Street (metered) parking on Ewing and Wayne Streets. On the street you plug the meters 8am –
5pm, weekdays only. It is free to park on the street after 5pm and on the weekends.
Visitor center/Grand Wayne Center garage at Washington and Clinton Streets. This is the Hilton
Hotel parking lot that also serves as a day parking garage. For hourly parking, 7am – 11 pm, charges
are .50 for the first 45 minutes, then $1.00 per hour. There is a flat $2.00 fee between 5pm and
11pm.
***************************************
Genealogy Center Queries
***************************************
The Genealogy Center hopes you find this newsletter interesting. Thank you for subscribing. We
cannot, however, answer personal research emails written to the e-zine address. The department
houses a Research Center that makes photocopies and conducts research for a fee.
If you have a general question about our collection, or are interested in the Research Center, please
telephone the library and speak to a librarian who will be glad to answer your general questions or
send you a research center form. Our telephone number is 260-421-1225. If you‛d like to email a
general information question about the department, please email: Genealogy@ACPL.Info.

***************************************
Publishing Note:
***************************************
This electronic newsletter is published by the Allen County Public Library's Genealogy Center, and
is intended to enlighten readers about genealogical research methods as well as inform them about
the vast resources of the Allen County Public Library. We welcome the wide distribution of this
newsletter and encourage readers to forward it to their friends and societies. All precautions have
been made to avoid errors. However, the publisher does not assume any liability to any party for
any loss or damage caused by errors or omissions, no matter the cause.
To subscribe to “Genealogy Gems,” simply use your browser to go to the website:
www.GenealogyCenter.org. Scroll to the bottom, click on E-zine, and fill out the form. You will be
notified with a confirmation email.
If you do not want to receive this e-zine, please follow the link at the very bottom of the issue of
Genealogy Gems you just received or send an email to kspears@acpl.lib.in.us with "unsubscribe ezine" in the subject line.
Steve Myers & Curt Witcher, co-editors

